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Deck 3.5 Addendumii

ソフトウェアの著作権および保証について
 
この法的文書は、エンドユーザー（あなた）と BIAS,Inc. 
との契約書です。あなたはこれらのディスクのソフト

ウェアを使用することによってこの契約書の条件に拘

束されることになりますが、この条件にはソフトウェ

アライセンスおよびソフトウェアに関する責任の放棄

（集合的に契約）が含まれます。この契約は、あなたと

BIAS,INC.との間の完全な契約に相当します。この契約の
条件に同意せず、全額返金を希望される場合は、このパッ

ケージに含まれるディスクのソフトウェアをご使用にな

らず、パッケージその他の品を未開封の状態で直ちにお

買い上げ店にご返品ください。

BIASソフトウェアライセンス
1.  ライセンスの付与。
ライセンス付与人である BIASは、本製品に対して支払わ
れた代価の一部であるライセンス料を考慮し、一カ所に

おいて１つのコンピュータでこの BIASソフトウェアプロ
グラム（以後ソフトウェアと呼ぶ）を使用し、表示する

非排他的権利を付与します。このライセンスに対して明

確に付与されない権利は BIAS が保有するものとします。 

2.  ソフトウェアの所有権。
あなたは、ソフトウェアを最初にまたはその後に記憶し

た磁気メディアその他の物理的メディアを所有するもの

とします。ただし、オリジナルディスクのコピー（また

は複数のコピー）に記憶されたソフトウェアおよびそれ

以降に作成したソフトウェアのコピーの所有権は、オリ

ジナルおよびコピーが記憶されたメディアの形態を問わ

ず BIASが所有するものとします。このライセンスは、オ
リジナルのソフトウェア /コピーの販売ではありません。

3.  コピーに関する制約。
このソフトウェアおよびそれに付属する印刷物には著作

権が設定されています。ソフトウェア（変更、統合、あ

るいは他のソフトウェアとともに含まれたソフトウェア

を含む）や印刷物を無断でコピーすることは禁止されて

います。あなたは、ライセンス違反を原因または誘因と

して発生した著作権の侵害に対して法的責任を負わされ

る場合があります。この制約に基づき、ソフトウェアの

コピープロテクトがかかっていない場合は、バックアッ

プを目的としてソフトウェアのコピーを 1つ作成するこ
とができます。バックアップコピーには、著作権に関す

る情報を含める必要があります。

4.  使用に関する制約。
ソフトウェアを一度に一つのコンピュータで使用する限

りにおいては、ライセンスの被付与人としてソフトウェ

アを一つのコンピュータから別のコンピュータに転送す

ることができます。ソフトウェアをネットワークを通じ

て電子的手段で一つのコンピュータから別のコンピュー

タに転送することはできません。ソフトウェアおよびそ

の関連印刷物のコピーを他人に配布することはできませ

ん。ソフトウェアをもとにした派生物を変更、改作、翻訳、

リバースエンジニアリング、逆コンパイル、分解、作成

することはできません。BIASが事前に書面で許可した場
合を除いては、印刷物を変更、改作、翻訳、作成するこ

とはできません。

5.  譲渡に関する制約。
このソフトウェアは、ライセンスの被付与人であるあな

たに対してのみライセンスが付与され、BIASの書面によ
る事前の許可なく他人にソフトウェアを譲渡することは

できません。ソフトウェアの正当な被譲渡人にはこの契

約書の条項が適用されます。ここに定める場合を除いて

は、いかなる場合もソフトウェアを一時的であれ永久的

であれ譲渡、貸与、販売、処分することはできません。

6.  ライセンスの終了。
このライセンスは、終了時まで有効とします。このライ

センスの条項に違反した場合は、ライセンスは BIASによ
る事前の通告なしに自動的に終了します。ライセンスが

終了した場合は、印刷物およびソフトウェアのすべての

コピー（修正したコピーがある場合はそれも含め）を破

棄されるべきものとします。 

7.  更新方法。
BIASは、随時ソフトウェアの新バージョンを作成できる
ものとします。BIAS は、更新料を支払い、登録カードを
返送したライセンスの被付与人および被譲渡人に対し、

BIASの判断に基づいて新バージョンの使用を認めるもの
とします。

8.  その他。
この契約はカリフォルニア州の法律が適用されます。
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保証の放棄および保証の制限

ソフトウェアおよび関連印刷物（使用説明書を含む）は、

一切の保証を付けずに提供されます。また、BIASはソフ
トウェアおよび関連印刷物の使用、使用の結果に対し、

妥当性、正確さ、信頼性、時宜性、その他の見地からの

いかなる保証も主張もするものではありません。

ソフトウェアの使用結果および性能に関する一切の危険

は、BIAS やその代理店、販売店、従業員ではなくユーザー
が引き受けるものとし、また、ユーザーは必要なあらゆ

るサービス、修理、訂正の費用を負担することに同意す

るものとします。BIASはライセンスの最初の被付与人に
対し、ソフトウェアが記憶されているディスクを正しく

使用した場合にはその材質および製造に欠陥がなく、領

収証の示す販売の日付から 90 日間は正しく使用できる
ことを保証します。BIAS は、ディスクに対する保証の期
間を上で示した期間に限るものとします。ディスクに対

する BIAS の全責任およびユーザーに対する対応策は、(a)
購入代金の返還、または、(b)BIASの限定保証の条件を
満たさないディスクの交換、のいずれかを BIASが選択す
るものとし、(b)の場合は領収証の写しとともにディス
クを BIAS に返送すべきものとします。ディスクの欠陥が
事故、誤用、不適正な用途への使用によるものであると

きは、BIASはディスクを交換または購入代金を返還する
義務を負わないものとします。交換したディスクの保証

期間は、もとのディスクの保証期間の残り期間または 30
日間のうちいずれか長いほうとします。上記は、明確に

示されたあるいは暗黙のあらゆる保証とし、BIAS が BIAS 
製品に対して提供する製造および特定の用途への適合性

に関する暗黙の保証を含むものとし、ただしそれに限ら

れないものとします。

BIAS、その代理店、販売店、従業員による口頭または書
面での情報提供や助言は、保証を生むものでもこの保証

の範囲を拡大させるものではなく、ユーザーはこのよう

な情報や助言に依存することはできません。この保証は、

ユーザーに特定の法的権利を付与します。ユーザーはそ

の他の権利を有する場合がありますが、その権利の内容

は州によって異なります。

BIAS、および本製品の作成、製造、配布に関与したいか
なる者もこのような損害を生じさせた直接的、間接的、

必然的、偶発的損害（事業収益の損失、事業の中断、事

業上の情報の損失、その他）に対する責任は負いません。

一部の州では必然的あるいは偶発的損害に対する責任の

免除あるいは制限を認めていないため、上記の制約は適

用されません。この保証の放棄および保証の制限にはカ

リフォルニア州の法律が適用されます。

アメリカ政府の権利の制限

ソフトウェアおよび印刷物には「権利の制限」条項

が適用されます。政府による使用、複製、公開は、

252.227-7013 の「技術データおよびコンピュータソフト
ウェアにおける権利」の (b)(3)(ii)で定める制約が適用さ
れます。請負人／製造者（"Contractor/manufacturer）は
BIAS (Berkley Integrated Audio Software),Inc.,1370 Industrial 
Avenue, Suite A, Petaluma, CA 94952です。

この契約に関するお問い合わせ先、および BIASへのご連
絡先は下記の通りです。BIAS,Inc.,1370 Industrial Avenue, 
Suite A, Petaluma, CA 94952

BIAS Customer Sales and Service
1370 Industrial Ave., Suite A
Petaluma, CA 94952
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BIASテクニカルサポート：

セルフヘルプオプション

BIAS製品のインストール /使用方法に関して疑問がある
場合には、最初にユーザーズガイドをチェックして下さ

い。大部分の疑問点は、ユーザーズガイドを参照するこ

とで解決されます。ユーザーズーガイドを参照しても解

決されない問題に直面した場合には、http://www.bias-inc
.com/support.htmlへアクセスし、データベースをチェッ
クして下さい。

技術的なサポート

サポート対象は、以下の 3つの TYPEに分かれています。
TYPE 1：BIAS製品（Peak・Peak TDM・Deck）を初めて購
入し、ご購入後 90日（最高）以内の方が利用できます。
TYPE 2：BIAS製品（Peak DV・Peak LE・Deck LE・vbox・
Super Freq）を初めて購入し、ご購入後 90日（最高）以
内の方が利用できます。

TYPE 3：BIAS製品（Peak・Peak TDM・Peak DV・Peak LE・
Deck・Deck LE・vbox・Super Freq）のアップグレードパッ
ケージを購入し、ご購入後 30日（最高）以内の方が利用
できます。OEMバージョンはサポートサービスを受けら
れません。

プロダクトオーソライゼーションコード（PAC）が発行
された時点で、サポート期間は開始します。電子メール

でお問い合わせ頂くか、電話にてサポートセンターへお

問い合わせ下さい。お問い合わせ頂く場合には、有効な

シリアル番号を必要とし、ユーザー登録が完了していな

ければなりません。シリアル番号と PACは、安全な場所
に保管して下さい。

電子メールにてサポートを受けるには、BIASのウェッブ
サイトへアクセスして下さい：

http://www.bias-inc.com/support.html
support@bias-inc.com

電話にてサポートを受けるには、コンピュータを起動し

た状態でお問い合わせ下さい：

+1-707-782-1865
9:00～ 17:00までの月曜日～金曜日（BIASの休みを除く）

Fee-basedテクニカルサポートのオプション

サポート期間が切れた場合や、OEM版のために利用でき
ます。

電話にてサポートを受けるには、コンピュータを起動し

た状態でお問い合わせ下さい：

+1-707-782-1865
9:00～ 17:00までの月曜日～金曜日（BIASの休みを除く）

北アメリカ以外にお住まいの方は、あなたの地方のディ

ストリビューターを探すために BIASのウェッブサイト
をチェックして下さい：

http://www.bias-inc.com/distributors.html

サポート方針と時間

サポート方針と時間は、予告なしに変更されることがあ

ります。

販売とカスタマー（非技術的）サービス

製品情報、販売店等に関するお問い合わせは、電子メー

ルまたはお電話にてお問い合わせ下さい：

sales@bias-inc.com
US: 1-800-775-BIAS (2427)
9:00～ 17:00までの月曜日～金曜日（BIASの休みを除く）

http://www.bias-inc.com/support.html
http://www.bias-inc.com/distributors.html
http://www.bias-inc.com/support.html
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Chapter 1:
Deckについて

Deck 3.5の新機能

Deck  3.5では、以下の機能をはじめとする新機能や強化
機能が追加されています。

• Mac OS Xのサポート

• Mac OS Xでの CoreAudio Frameworkのサポート 

• Mac OS Xでの CoreMIDI Frameworkのサポート 

• 美しい“Aqua”ユーザーインターフェース（GUI）のサポー

ト 

• 5.1chサラウンドミキシング

• OMFファイルのインポート

• フェーダーのリンク

• BIAS Freq ™ VST Plug-In (カーボナイズ )をバンドル（Mac 

OS 8.6～ 9.2・Mac OS Xサポート） 

Mac OS 8.6～ 9.2で必要な環境

• G3もしくは G4プロセッサを搭載した PowerBookを含

む Macintosh(266MHz以上の処理速度を持つプロセッサ

を推奨 )

• 64MBの搭載メモリ

• SoundManager 3.4以降のバージョン

• Mac OS 8.6以降のバージョン

• CarbonLib 1.4以降のバージョン

• QuickTime 4以降のバージョン

• QuickTime PowerPlugがインストールされている機能拡

張フォルダ

• 16bitの Macintosh内蔵オーディオ入出力または

SoundManagerに対応したオーデオハードウェアもしく

は ASIOに対応したオーディオハードウェア

• SMPTE/EBUタイムコードを使用し、外部との精密なフ

レームシンクを行うためには、OMSに対応したハード

ウェアを必要とします。

• Deckと OMS対応の MIDIシーケンサーや MIDIトラッ

クとのシンクロナイズを行うには OMS2.3.8以降のバー

ジョンが必要になります。

• 7200回転以上の高速なハードディスクドライブ

• 13インチ以上のモニタ（カラーディスプレイ推奨）

• Deckと OMS対応の MIDIシーケンサーや MIDIトラッ

クとのシンクロナイズを行うには OMS 2.3.8以降のバー

ジョンが必要になります。

Deck 3.5 は、Nubus を使用する Power PC 機では動
作しません。

Mac OS Xで必要な環境

• G3もしくは G4プロセッサを搭載した PowerBookを含

む Macintosh(266MHz以上の処理速度を持つプロセッサ

を推奨 )

• Mac OS X 10.1.5以降

• 128MBの搭載メモリ

• 7200回転以上の高速なハードディスクドライブ

• カラーディスプレイ（640 x 480以上推奨）

• CoreAudioに対応したオーディオハードウェア

• SMPTE/EBUタイムコードを使用し、外部との精密なフ

レームシンクを行うためには、CoreMIDIに対応したハー

ドウェアを必要とします。
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録音と再生

Deckをご利用頂くには、PowerPC,G3又は G4を搭載し
た Macintoshをご利用頂く必要がございます。Mac OS X
の場合、Deckは CoreAudioに対応したサウンドカードの
使用をサポートをしています。Mac OS 8.6～ 9.2の場合、
Deckは ASIO 1.0に対応したサウンドカードをサポートし
ています。

トラックの録音と再生には、更に以下の条件が必要とな

ります。

• ラインレベルのソース（ミキサー・シンセサイザー等の

電子楽器・CDプレイヤー・ターンテーブル・カセット

プレイヤー・DAT・マイクロフォン等）

• プレイバックを行うため、Mac内蔵のスピーカー・ヘッ

ドフォン・ステレオ対応のアンプとスピーカー又はパ

ワードスピーカー

• ミキサーか、ASIO対応ハードウェアに付属したオンボー

ドミキサー（Tascam US-428等）の使用を強くお勧めし

ます。

 

最高のパフォーマンスを得るために

Macintoshで Deck のパフォーマンスを最大限に引き出す
ためには、以下の作業を行って下さい。

Mac OS 8.6～ 9.xでDeckのパフォーマンスを最大限に引き出す： 

• システムで使用する拡張機能の数を最小限に抑えます。

拡張機能は、貴重なプロセッササイクルを使用するため、

Macintosh のスピードを低下させる恐れがあります。特

に常時作動しているメニューバークロックやスクリーン

セーバーは無効にして下さい。機能拡張マネージャーを

使用して、Mac OS 基本セットをコピーして「Deckセッ

ト」などの名称を付けて下さい。このセットで再起動

し、Deck をインストールします。Deck に必要な機能拡

張ファイルが追加されますので、再度更新されたセット

で再起動して下さい。

• ファイル共有を無効にします。

• Macintosh から一切のネットワークへの接続を切断し、

AppleTalk を無効にします。

• 可能な場合は、Findeの“情報を見る”コマンドを利

用して Deck に割り当てるメモリの容量を増やします。

（Finderで Deck を選択し、Finderの“ファイル”メニュー

で“情報を見る”を選択し、“使用サイズ”フィールド

に値を入力します。必ず“最小サイズ”フィールドが

示す容量よりも大きな容量を割り当てます）

• ハードディスクドライブを最適化します。

OSの違い（Mac OS 8.6～ 9.2と Mac 
OS X）による Deck 3.5の相違点

カーボナイズされた（Mac OS X対応の）Deck 3.5は、
Mac OS XとMac OS 8.6～ 9.2のいずれでも動作しますが、
OSの持つ能力の違いにより、その機能にも相違点があ
ります。以下はその相違点についての説明です。

Premiereプラグイン
Deck 3.5 では、MacOS 8.6 ～ 9.2 での動作において
Premiereフォーマットのプラグインの使用をサポートし
ています。（Premiereプラグインは、MacOSXではサポー
トされていません）

VSTプラグイン
Mac OS 8.6～ 9.2で使用する場合は、カーボナイズさ
れているか否かに関わらず、VSTプラグインを使用す
る事ができます。また、Deck 3.5を Mac OS X上で使
用する場合は、VSTプラグインもカーボナイズされた
ものが必要になります。ご使用の VSTプラグインがカー
ボナイズされているかに関しては、プラグインのメー

カーまでお問い合わせ下さい。

ASIO
Deck 3.5を Mac OS 8.6～ 9.2で動作させる場合、ASIO 
1.0ドライバを使用して録音 /再生をする事ができます。
ASIO 1.0のテクノロジーは、Mac OS Xから採用された
“CoreAudio”システムとの互換性はありません。
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• Macintosh ウィンドウの呼び出し、終了、スクロール、

移動、拡大／縮小、選択

Deckを容易に使いこなせるように、これらの操作方法が
分からない場合には Macintoshのユーザーズガイドをお
読みになり、操作方法を理解した上で先にお進み下さい。

このマークのある箇所には重要なヒントや注意が

記載されています。

協定
Deckユーザーズガイドは、メニューの選択およびキー
コマンドを示す場合に、次の協定を使用します：

     協定       アクション

     File > Save  Fileメニューから Save
                コマンドを選択する

     -S         キーと Sキーを押す

     Option-クリック  Optionキーを押しなが
               らマウスをクリックする

Deck LE 3.5について

Deck の限定版（“LE” = limited edition）では、使用でき
ない機能もあります。特に、下に示す機能は Deck LEで
は使用できません。

• 12トラックまでの録音 /再生

• バーチャル（仮想）トラック

• サラウンドパンニング

• OMFファイルのインポート

• Levelと Panのフェーダー情報の記録

• エンベロープのオートメーション

• リアルタイム DSPエフェクト

• Adobe Premiere Plug-Inのサポート

CoreAudio
Deck 3.5を Mac OS Xで動作させる場合、CoreAudioを使
用して録音 /再生をする事ができます。
Deckは CoreAudioダイアログで選択したデバイスを使用
して音声の再生 /録音を行います。CoreAudioには数々
の高度な機能があり、複数のアプリケーションでのドラ

イバの共有、高いビット解像度 /サンプリング周波数の
サポート等を低レイテンシーで実現します。

Graphical User Interface
Deckの GUI（グラフィカルユーザーインターフェース）
は、MacOS 8.6～ 9.2でも Mac OS Xでもほとんど違いは
ありません。Mac OS Xでは、OS Xで採用された大きな
アプリケーションアイコンや“aqua”スタイルの表示方
法が、GUI全体にわたって実現されています。

ユーザーズガイドについて

本ユーザーズガイドは、Deck 3.5の新機能・システム
必要条件・設定方法・オーソライゼーションの方法に関

して記述されています。Deckの基本的な操作方法等は、
Deck 3.0ユーザーズガイドを参照して下さい。

Deckは、単純かつ直感的に理解できるように設計されて
います。ユーザーズガイドは、デジタル録音／編集に備

えて Deck をできる限り迅速かつ容易にセットアップし、
使用できるようにするための手引きとして書かれていま

す。

ユーザーズガイドは、読者が下記を含む Macintoshの基
本的な操作方法を身に付けている事を前提として書かれ

ています。

• Macintosh のセットアップ、起動、及び使用

• メニューからコマンドを選択

• マウスを利用した Wクリック、選択、シフトの切り替え、

ドラッグ

• ファイルの呼び出し、コピー、保存、削除
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• VST Plug-Inのサポート

• QuickTimeムービーのサポート

• MIDIタイムコードの同期と SMPTE/EBUのサポート



Chapter 2
Deckのインストールと設定
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2
Chapter 2:
Deckのインストールと
設定

Deckは、パワフルでハイエンドなエディッティング・ミ
キシング・オーディオプロセッシング・シンクロナイゼー

ションを提供します。Deckを使用するには、Deckをイ
ンストールし、オーディオハードウェアの設定を行う必

要があります。オーディオハードウェアは、Macintosh内
蔵 16Bitシステム、または PCI・PCMCIA・USB・Firewire
のオーディオハードウェアを使用することができ、ミキ

サー・アンプ・スピーカーとのコンビネーションで使用

することもできます。

Deckのインストール

Deckソフトウェアには、インストールを容易にする自動
インストール機能（“auto-installer”）が用意されています。

Deckシステムは、下記で構成されています。

• CD-ROMインストーラー

• Deckシリアルナンバーとオーソライゼイションコー

ド (PAC)

Deckをインストールする前に、P.3に記載されて
いる動作環境を満たしているか確認して下さい。

Deckをインストールする：

1. ウイルス撃退ソフトウェアを使用している場合には、そ

のプログラムをオフにするか、または一時的に削除した

のち Macintoshを再起動します。

2. CD-ROMドライブに Deckの CD-ROMをセットして

“Product Installers”フォルダを開き、“Install Deck”アイ

コンを Wクリックして下さい。

3. “Installer”のダイアログボックスが表示されたら、“Read 

Me”でインストールに関する情報を確認したのち、

“Continue”をクリックして先へ進みます。

4. “Switch Disk”ポップアップメニューで、Deckをインス

トールするハードディスクを選択します。

5. ダイアログ右下の“Install”をクリックします。

6. “Install”をクリックした後は、画面に表示される指示に

従って下さい。Deckは、選択したハードディスクへ“Deck 

3.5”フォルダを作成しインストールします。

7. インストールの完了時に、オンラインによる Deckの登

録を促すダイアログボックスが表示されます。日本語で

登録を行う場合には、“I`ve already registered”をクリッ

クします。英語でのオンライン登録を希望する場合には、

“Register”をクリックして登録を行います。詳しくは、

別紙インストールガイドを参照して下さい。

8. インストールが完了すると、インストールが適切に終了

したことを表すメッセージが表示されます。インストー

ルを終了する場合には“Quit”をクリックします。続

けて別のハードディスクへインストールする場合には、

“Continue”をクリックします。（次回 Macintoshを再起

動する際にウイルス撃退ソフトウェアをオンに戻すこと

を忘れないように注意して下さい。）

Deckのインストール後は、オーソライゼーション
コード（PAC）の取得や、テクニカルサポート /バー
ジョンアップサービスを受けるためにユーザー登

録を行って下さい。ユーザー登録方法は、別紙イ

ンストールガイドを参照して下さい。

オーソライズ

Deckは、使用する前にオーソライズする必要があります。
オーソライズ時には、Deckの“Owner's Certificate”に表
示されたシリアルナンバーの他に、PAC（プロダクトオー
ソライゼーションコード）が必要になります。BIASでは、
ユーザー登録の確認後に PACをお送りしています。

お早めにユーザー登録を済ませて PACを受け取っ
て下さい。氏名・組織（会社）名・シリアルナンバー・
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PACを登録しないままですと、使用開始から 14日
が過ぎると Deckは起動しなくなります。

Deckを初めて起動する際に、氏名・組織（会社）名・シ
リアルナンバー・オーソライゼーション（PAC）の入力
を促すダイアログボックスが表示されます。

もし PACをお持ちでない場合、Deckのレジストレーショ
ンモードで 14日間だけ全ての機能をご利用頂けます。こ
の間に Biasまたは輸入代理店からオーソライゼーション
コード（PAC）を取得して下さい。レジストレーションモー
ドで Deckを起動する場合は起動時に表示されるダイア
ログボックスより“Still waiting for Product Authorization 
Code”ボタン押して下さい。また、プロダクトオーソラ
イゼーションコード（PAC）が発行され次第、起動時に
表示されるダイアログボックスに氏名・組織（会社）名・

シリアルナンバー・プロダクトオーソライゼーション

コード（PAC）の入力を行い“Authorize”をクリックす
る事によりオーソライズは完了します。

オーディオ接続

Deckは、Macintosh内蔵のサウンドシステムと同様に
CoreAudio（Mac OS X）またはApple SoundManager・ASIO（Mac 
OS 8.6～ 9.2）互換のオーディオ・ハードウェアをサポー
トしています。また Deckでは、ダイレクトに Tascam 
428 USBオーディオ・インターフェース (ASIO)をサポー
トします。

インストール方法の詳細は、使用しているオーディオ・

カード /インターフェースの資料を参照して下さい。

Macintoshとミキサーやスピーカーシステムとのオーディ
オ接続は、簡単にセットアップできます。実際のセット

アップは、Macintoshに内蔵された入出力コネクタを使
用する場合と、サードパーティのオーディオ録音／再生

システムを使用する場合とでは若干異なります。以下で、

それぞれの場合について説明します。

Macintosh内蔵のサウンド入出力を使用する

Macintosh内蔵の音声入力／出力端子を使用して録音
や再生を行う場合は、次の設定を行って下さい。

1. 再生システムのボリュームを下げます。Deckでは、下

記をはじめとする様々な再生システムが使用できます。

• ヘッドフォーン

• ステレオレシーバー、またはアンプ+スピーカー

• ミキサー+アンプ+スピーカー 1組

• ミキサー+アンプ内蔵スピーカー

• または、単純に 1組のアンプ内蔵スピーカー（小型な

ものは、一般的にマルチメディアスピーカーと呼ばれ

ます。）

2. オーディオソース（音源）の出力を、Macintoshのオーディ

オ入力コネクターへ接続します。オーディオのソース（音

源）には、下記のいずれかを使用できます。

 •カセット、または DATの出力

 •ミキサーの出力

 •ステレオレシーバーのライン出力（テープデッキ録音

出力等）

 •楽器のライン出力（シンセサイザーの出力やギターの

プリアンプ出力等）

Macintoshのオーディオ入出力端子は、標準的なステレオ
のミニプラグ（1/8インチ）コネクタです。一方、ミキサー
やレシーバ、アクティブスピーカーの入力は、多くの場

合 XLRか 1/4インチジャック、RCA、またはミニプラグ
を使用しています。これらの機器と正しく接続するには、

それぞれに対応するアダプタを使用して下さい。

サードパーティのオーディオインターフェースを

使用する場合には、Macintosh内蔵の音声入力は使
用できなくなります。

上級ユーザーへのご注意：プロフェッショナル用

のミキシングコンソールや DATデッキなどの中に
は、公称出力レベルが“+4dBu”の製品がありま
すが、Macintoshでは公称“-10dBV”を想定してい
ます。従って、Macintoshの入力回路への過負荷を
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避けるため必要に応じてミキサー等の出力レベル

を調整するか、または“+4対 -10”のトランスを
使用して下さい。

3. Macintoshのオーディオ出力を、再生システムの入力へ

接続します。Macintoshのオーディオ出力端子は、標準

的なステレオのミニプラグ（1/8インチ）コネクタです。

一方、ミキサーやレシーバ、アクティブスピーカーの入

力は、多くの場合 XLRか 1/4インチジャック、RCA、ま

たはミニプラグを使用しています。これらの機器と正し

く接続するには、それぞれに対応するアダプタを使用し

て下さい。

4. ミキサー、または再生システムのボリュームを上げます。

この時、システムは適切に設定され、録音 /再生可能な

状態になっていなければなりません。

PCI・PCMCIA・USB・FireWireのオーディオインター
フェース
CoreAudio（Mac OS X）や Sound Manager・ASIO（Mac OS 8.6
～ 9.2）と互換性のあるオーディオインターフェース（PCI・
PCMCIA（カードバス）・USB・FireWire等）が実装されて
おり、これらの入出力端子を使用して録音や再生を行う

場合は、次の設定を行って下さい。

1. ミキサー、または再生装置のボリュームを小さくして下

さい。

2. PCIタイプのオーディオインターフェースの場合には、

Macintoshの PCI拡張スロットへインストールします。

PCMCIAタイプのオーディオインターフェースの場合に

は、PowerBookの PCMCIAスロットへインストールしま

す。USBまたは FireWireタイプのオーディオインター

フェースの場合には、Macintoshの USBまたは FireWire

ポートへ接続します。サードパーティのオーディオイン

ターフェースが手順通りに取り付けられているかどうか

確認して下さい。設置方法がよく分からない場合には、

オーディオインターフェースのマニュアルに従って下さ

い。

3. 各オーディオインターフェースの CoreAudio（Mac OS X）

や Sound Manager・ASIO（Mac OS 8.6～ 9.2）のドライバ

をインストールします。インストールの際は、各メーカー

のマニュアルに従って下さい。

 ASIO互換のオーディオインターフェースを使用するに

は、Deckの“ASIO Drivers”フォルダへ ASIOドライバ

をインストールして下さい。

4. 音源の出力とオーディオインターフェースの入力を接続

します。

5. オーディオインターフェースの出力とミキサー（または

再生装置）の入力を接続します。

6. ミキサー等の再生装置のボリュームを上げて下さい。以

上で録再生のためのシステムが構築されました。

一般的なミキサーとコンピューターとの接続方

法は、コンピューターの出力からミキサーのチャ

ンネル入力に、ミキサーの AUXや BUSからコン
ピューターの入力へ接続します。録音したい楽器

はミキサーの他のチャンネル入力へ接続し、その

音をミキサーの AUXや BUSのセンドへ送りコン
ピューターで録音します。ミキサーのメイン出力

はアンプ /スピーカーへ接続します。

Apple Sound Manager

Deck 3.5は、Mac OS 8.6～ 9.2での録音再生において 
Apple Sound Managerのオーディオドライバでの動作をサ
ポートしたオーディオインターフェースの使用を行う事

ができます。Apple SoundManagerはアップルコンピュー
タにより開発されたサウンドカードとソフトウェア間の

ルーティングを行う基礎テクノロジーです。

Apple Sound Manager使用時の設定方法
Apple Sound Managerとオーディオインターフェースで
Deckを使用するには、Apple Sound Manager対応のオー
ディオインターフェースドライバがインストールされて

いる必要がございます。ほとんどのサードパーティー製

のオーディオインターフェースは固有のコントロールパ

ネル及び Apple Sound Manager設定用ユーティリティー
等のソフトウェアを装備しています。各設定の詳細は、

製造元から提供されるマニュアルをご参照下さい。
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Apple Sound Managerとオーディオインターフェースで
Deckを使用するには：

1. ご利用のオーディオインターフェースの Apple 

SoundManager用ドライバを製造元から提供されたマ

ニュアルに従いインストールします。

2. コントロールパネルのサウンドで“出力”タブを選択し

ます。

3. サウンドを出力するオーディオインターフェースを選択

します。（例ではDigigram VX Pocketが表示されています）

サウンド・コントロールパネル

4. コントロールパネルのサウンドで“入力”タブを選択し

ます。

5. サウンドを出力するオーディオインターフェースを選択

します。

6. サウンド・コントロールパネルを閉じます。

ASIO

Deck 3.5は、Mac OS 8.6～ 9.2での録音再生において 
ASIOのオーディオドライバでの動作をサポートしたオー
ディオインターフェースを使用する事ができます。ASIO
は Steinberg Media Technologies AG.によって開発された、
サウンドカードとソフトウェア間のルーティングを行う

コアテクノロジーです。ASIOは AppleSoundManagerと異
なりマルチチャンネルの使用が可能となります。

ASIO使用時の設定方法
ASIO互換のオーディオインターフェースで Deckを使用
するには、ASIO対応のオーディオインターフェースドラ
イバが Deckフォルダ内の Plug-inフォルダに ASIO Plug-In
がインストールされている必要がございます。

ASIOドライバのインストール方法
ASIOドライバのインストールを行い Deckを使用する場
合、ASIOでの動作をサポートしたオーディオインター
フェースの ASIOドライバを Deckフォルダ内の“ASIO 
Drivers” フォルダへドラッグ＆ドロップします。

Deckに正しく ASIOドライバの認識を行わせるために、
Deckの起動用アイコンが“ASIO Drivers” フォルダと同じ
階層（Deckフォルダの中）に存在する様にして下さい。

Deckの“ASIO Drivers” フォルダ内には使用する ASIOド
ライバ一つのみインストールされた状態にして下さい。

使用しない他の ASIOドライバは“ASIO Drivers（Unused）”
フォルダに保管し、必要に応じて“ASIO Drivers” フォル
ダ内にインストールするドライバを入れ替えてご利用下

さい。

ASIOドライバのインストールを終え Deckを起動すると、
“ASIO Drivers” フォルダ”にインストールした ASIOドラ
イバをロードして起動します。

CoreAudio

Deck 3.5は、Mac OS Xでの録音再生において CoreAudio
ドライバでの動作をサポートしたオーディオインター

フェースを使用する事ができます。CoreAudioは Apple社
によって開発された、サウンドカードとソフトウェア間

のルーティングを行うコアテクノロジーです。CoreAudio
は Apple SoundManagerと異なりマルチチャンネルの使用
が可能となります。

CoreAudio使用時の設定方法
CoreAudioとオーディオインターフェースで Deckを使
用するには、フォルダ内の Plug-inフォルダに CoreAudio 
Plug-Inがインストールされている必要がございます。



13Installing and Configuring Deck

2
ハードウェアの設定

Deckを開いてからまずオーディオインターフェース
の設定を行います。AppleSoundManager・ASIO又は
CoreAudioのうち、どのハードウェアを使用するかを
“HardwareConfiguration” ダイアログで設定します。

Optionsメニューから“HardwareConfiguration...”をクリッ
クし、“HardwareConfiguration...”ダイアログを表示させ
て下さい。

オーディオカード
AudioCardポップアップメニューから使用するオーディ
オカードを選択して下さい。

AppleSoundManager

AudioCardポップアップメニューから、SoundManager（Mac 
OS 8.6～ 9.2のみ）の選択を行うと Apple コントロール
パネルの入力及び出力で設定したポートから Deckの入
出力を行う事ができます。

ASIO

AudioCardポップアップメニューから、マルチチャン
ネル入出力をサポートしたオーディオハードウェア用 
ASIO ドライバ（Mac OS 8.6～ 9.2のみ）の選択を行うと、
ASIOドライバ対応のオーディオインターフェースで使用
できる入力及び出力ポートの全てを利用して Deckの入
出力を行う事ができます。

CoreAudio

AudioCardポップアップメニューから、マルチチャン
ネル入出力をサポートしたオーディオハードウェア

用 CoreAudioドライバ（OS Xのみ）の選択を行うと、 
CoreAudioドライバ対応のオーディオインターフェース
で使用できる入力及び出力ポートの全てを利用して Deck
の入出力を行う事ができます。

クロックソース
デジタルオーディオ信号（SPDIF、ADAT等）を録音する
場合には、クロックソースが適切なデジタルに設定され

ることが重要です。不正確なクロックソースでデジタル

信号を録音すると「ジッター」エラーが発生します。また、

録音されたオーディオシグナルは、クリックとポップス

ノイズが含まれてしまいます。
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Play audio while in background
Play audio while in background のチェックボックスに
チェックを入れると、Deckがバックグラウンドで起動し
ている場合でもオーディオの再生が可能となります。例

えば他のオーディオアプリケーション（Bias Peak等）で
同じ ASIOドライバを使用して編集を行う際、バックグ
ラウンドで Deckのオーディオを参照する事ができます。

Record monitoring
録音している間、デジタルドメインでオーディオ入力を

モニターしたい場合には、“Hardware Configuration”ダイ
アログで設定を行って下さい。

デジタルドメインで録音をモニターするには：

1. Hardware Configurationダイアログで“Record 
monitoring”にチェックを入れます。

2. レコーディングするトラックの“Channel Input”を選ん

で下さい。

3. トラックの録音を有効にします。

4. 録音を開始します。

ライブレコーディングまたはオーバーダビングを行うと

きは、アナログドメインで録音をモニターすることを強

く推奨します。Deckでレコーディングする間、アナログ
オーディオ信号をモニターするためにアナログミキサー

を使用して下さい。Deckでレコーディングをモニターす
る場合、ASIOバッファー（2,048バイトのバッファーサ
イズの場合、44,100で 93msの遅れが生じます）に依存
します。アナログドメインでレコーディングをモニター

すればこの問題を回避できます。

アナログドメインで録音をモニターするには：

1. Hardware Configurationダイアログで“Record 
monitoring”のチェックを外します。

2. 録音するアナログ信号がオーディオインタフェースの入

力に接続され、モニターするスピーカーへもルートされ

ているか確認して下さい。

3. レコーディングするトラックの“Channel Input”を選ん

で下さい。

4. トラックの録音を有効にします。

5. 録音を開始します。

ハードウェアオプション

Deckの Optionメニューから Hardware Optionオプション
を選択すると、ASIO互換のサウンドカードの ASIOドラ
イバユーティリティーまたは CoreAudio互換のサウンド
カードの CoreAudioドライバユーティリティーを起動す
ることができます。

Digidesignハードウェアセットアップダイアログ

Digigram VX Pocketコントロールパネル

一部のサウンドカードでは、ドライバユーティ

リティーを備えていない場合があります。また、

Deckから直接アクセスできないドライバユーティ
リティー（MOTU PCI-324・M-Audio DELTAシリー
ズ等）の場合には、Deckを起動する前に初設定を
行う必要があります。
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2
Deckでの最大トラック数設定

Deckが適切なハードウェアにセットされていることを確
認して下さい。通常、最適な設定を自動的に行います。

Deckの以前のバージョンからアップグレードしている場
合や、コンピュータを買替えた場合には、再生トラック

数を設定する必要があります。

最大トラック数を設定をするには：

1. Optionsメニュー＞“Hardware Configuration”を選択し

ます。

2. Audio Cardポップアップメニューから、使用しているオー

ディオハードウェアを選択し、“OK”をクリックします。

3.Fileメニュー＞ Preferences＞“Memory & Storage”を選

択します。

4.“Max. play Tracks”に希望する再生トラック数を入力
します。（ほとんどの場合、最適な値がデフォルトで

設定されています）使用できる最大の再生トラック

数は、オペレーティングシステムとハードウェアの

性能に依存します。

Memory & Storage preferencesダイアログ

常に利用できる最大の再生トラック数をセットす

ることができますが、“Disk is too slow”メッセー
ジが表示される場合や、インターフェースの反応

が悪い場合には、ここの設定を確認して下さい。

最適なトラックカウントは、多くの要因（例えばハード

ディスクドライブの速度や CPUの速度）に依存します。

オーディオ専用のドライブを使う
システムがインストールされたドライブで録音や再生を

行うと、システムのパフォーマンスが低下します。

最適のパフォーマンスを得るためには、システムがイン

ストールされていない SCSIドライブに録音や再生を行っ
て下さい。7,200rpmまたは、より高速なオーディオ専用
のドライブを使うと、Deckのトラック数とパフォーマン
スを向上させることができます。

UW-SCSIは高性能ドライブの基準ですが、UDMA-66ドラ
イブでもほとんど同じパフォーマンスを得ることができ

ます。また、Firewireドライブは、データ転送最高 30gb/
秒を提供しています。（16ビットの 44,100Hzのオーディ
オ 1トラック=88kb/秒）
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Chapter 3:
Deck 3.5の新機能

5.1サラウンドミキシング

Deck 3.5では、ステレオ 2chミキシングに加え 5.1chサ
ラウンドミキシングのサポートをしています。Deckでサ
ラウンドの編集及びミキシングを行うには以下の条件が

必要となります。

• 6ch以上の出力ポートを持つオーディオインターフェー

ス（製造元から提供されるマニュアルに従い、マルチチャ

ンネル出力を行えるようオーディオインターフェースが

設置されているかをご確認下さい）

• 5つの同じスピーカーとサブウーファーを一般的な 5.1ch

サラウンドで用いられる配置にする。

            Center

Left                                                   Right

                         “sweet spot”

Surround Left                          Surround Right

“Left/Rightスピーカー”は通常のステレオ 2chと同じ場
所に配置します。“Centerスピーカー”は前方中央に配
置します。“Surround Left/Rightスピーカー”は“Left/Right
スピーカー”と対に向かい合うよう後方に配置します。

また、サブウーファーは指向性を持たないため、設置す

る場所は特に指定はございません。（一般的には、前方

又は左右前方に置きます）各スピーカーを設置する際に

は、製造元より提供されるマニュアルに従い設置を行っ

て下さい。

正確にレベルバランスがとれた状態で再生を行

うために、スピーカーの口径を把握して下さい。

これは、スピーカーを配置するポジションやパ

フォーマンスのバランスを考慮する上で役に立ち

ます。

5.1chサラウンドセッションの作成

新たに 5.1chサラウンドセッションを作成するには：

1. “File”> “NewSession”を選択します。

2.“NewSession”ダイアログ内で“Save”を行う際、使

用するセッションの名前を入力します。

3.“SessionSampleRate”ポップアップメニューから使用す

るサンプリングレートを設定します。

4.“Mixing Mode”から 5.1Surroundを選択します。

5.“Save”をクリックしてセッションを作成します。

5.1chサラウンドのモニタリング

新たに 5.1chサラウンドセッションを作成するには：

1. “Window”> “MasterOutputs”をクリックして

“MasterOutputs”ウィンドウを展開します。ウィンドウ

の上半分に表示される 6chアウトプットセレクタの各

ポップアップメニューをクリックします。

2.展開したチャンネルアウトプットセレクタのポップアッ

プメニューより、それぞれのスピーカーの接続に一致す

る様、各出力ポートを選択します。
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5.1chサラウンドセッションの場合表示される“Mixer”ウィンド
ウ

“Surround Panner”の円形部分は 5つのスピーカーに囲
まれているサラウンドエリアの二次元空間を表します。

（Left、Center、Right、SurroundLeft、SurroundRight）

ChannelI/O
ポップアップメニュー

MasterOutputsWindow

“MasterOutputs”ウィンドウの下半分で表示されている 6
本のメーターは、6chそれぞれの出力レベルを表します。
このメーターでそのチャンネル出力がオーディオイン

ターフェースに正しくルートされているかどうかの確認

が行えます。さらにウィンドウ内の“Master Gain”では、
マスター出力のボリューム調整を行う事ができます。

サラウンドパンニング
5.1chサラウンドのセッションで“Mixer”ウィンドウを
展開させた場合、ステレオセッションで表示されたパン

ニングスライダーが、表示される代わりに、サラウンド

エリアを表現する“Surround Panner”が表示されます。

Pan Control

Enable LFE

ボタン

LFE Lecel

スライダー

Track Selector

ポップアップメニュー
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サラウンドパンナーウィンドウ

セッション再生時に“Surround Panner”ウィンドウの中
にある“Pan Control”をクリック &ドラッグ（中心にあ
るボール）する事により、サラウンドエリア内のパンニ

ングを行う事ができます。さらに、ステレオセッション

と同様に、サラウンドパンニングの動きの記録、または

ブレークポイントの編集によりサラウンドパンニング情

報のオートメーションを組む事も可能です。サラウンド

セッションでは L/Rのコントロールに加え前後のパンコ
ントロールを各トラックで行う事ができます。

各トラックの Surround Pannerの設定
Mixerウィンドウを開き、各トラック上の小さな“Surround 
Panner”をクリックする事により“Surround Panner”ウィ
ンドウが展開されます。“Surround Panner”は、様々な
カスタマイズを行う事が可能です。

第一にパンニングの信号を伝えるかどうかの指定を個々

のスピーカー出力のON/OFFをおこないます。スピーカー
の ON/OFFを行うには Left 、 Center 、 Right 、 LeftSurround、

RightSurroundの各スピーカーを表すグリーンのボタンを
クリックします。デフォルトの状態では、全てのスピー

カーの出力が ONになっています。例えば 4chのパンニ
ングを行う場合には、センタースピーカーの出力を OFF
にします。ステレオのパンニングのみ行う場合には、そ

れに加えてサラウンドスピーカーの出力を OFFにしま
す。以上のように、各スピーカーの ON/OFFを行い対象
となるトラックをどのスピーカーでパンニングを行うか

を設定します。但し、このセッティングのオートメーショ

ンを組む事はできません。

“Surround Panner”ウィンドウの下部にある Enable LFE
（LowFrequency Effects）ボタンではサブウーファーチャン
ネル出力の ON/OFFを切り替えます。“Surround Panner”
の EnableLFEボタンを ONにした場合、サブウーファー
へ低音域の信号が送られます。この場合、他の 5つのチャ
ンネルの低音域信号が取り除かれる事はありません。こ

の結果、対象となるトラックからの低音域をサブウー

ファーからモニタリングする事ができます。また、“LFE 
Level”スライダーでは音圧のレベル調整を行う事ができ
ます。さらに“LFEFrequency”ではサブウーファーから
出力する周波数を調整する事もできます。

民生用のサラウンドデコーダーは、各サテライト

スピーカーからの低音を削除してサブウーファー

へその信号を送る仕様になっているため、LFEを
メインチャンネルの低音除去に使用しないで下さ

い。

Surround Pannerウィンドウの上部にあるポップアップメ
ニューを使用する事でサラウンドパンニング“Algorithm”
を切り替える事ができます。Deckでは“Width” “Angle” 
“Ambient”の 3タイプのサラウンドパンニングアルゴリ
ズムを搭載しています。トラックでどのような種類の信

号を扱うかをサラウンドパンニングアルゴリズムで定義

します。

Width̶デフォルトの状態である“Width”は一般的な
セッティングです。“Pan Control”をサラウンドサークル
の端に近付ける事で、再生される音がボールの位置に従

いフォーカスされます。また、サークルの中心にボール

を移動させると全チャンネルの出力が同じになり再生さ

れる音に広がりを与える事ができます。このアルゴリズ

ムは、頭上を飛び去る飛行機の様なサラウンドエリアの

中間を移動する音の表現に役立ちます。

Surround Panner

Algorithmポップアップメニュー
Channel On/Off

ボタン

Pan Control

Enable LFE

ボタン

LFE Lecel

スライダー

Track Selector

ポップアップメニュー
LFEFrequency

スライダー
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Angle̶“Angle”は可変するイメージを持たない点で
“Width”と異ったアルゴリズムを持ちます。“Angle”
は特定の角度から音を出力する時に役立つアルゴリズム

です。このアルゴリズムを選択すると、“Pan Control”
のボールはサークルの端のみ移動するようになります。

“Angle”はスイートスポットを中心に円を描く様に移動
する音の表現に役立ちます。

Ambient̶“Ambient”は、主体となる音の周りにあ
る、室内の静的環境音を表現する場合に大変適していま

す。サラウンドボールを中心から端に移動するにつれて

部屋の環境音のボリュームが上がり、距離感のある表現

のミックスを可能とします。このアルゴリズムではサラ

ウンドエリア内の中心を移動する音に対しても有効です

が、動的ではない室内の音（環境音機械の音や窓から入

る車の音等）の表現に最も適しています。

5.1chセッションのミックス
5.1chセッションをディスクに書き出す場合、“Process”
>“MixToDisk”をクリックします。サラウンドモード
ではモノラル 16-bitAIFFファイルのみのサポートとなる
ため、展開されたダイアログはファイルタイプを変更す

るためのポップアップメニューはグレイアウトします。

“Save”をクリックした後、Deckは L、R、、C、LS、RSの
計 6つのモノラル AIFFファイルを作成します。ドルビー
デジタルへのエンコードは通常このタイプのフォーマッ

トパッケージをサポートしています。

OMFファイルのインポート

Deck 3.5は他のアプリケーションから OMFファイル
（Final Cut Pro・Pro Tools・Avid・DigitalPerformer・

Nuendo等）をインポートする事ができます。OMFファ
イルは、編集を行ったセッションとタイムロケーション

を含んだフォーマットです。

Deckに OMFファイルをインポートするには：

1.File>“ImportOMF”を選択します。

2.展開されたダイアログからインポートする OMFファイ

ル（ファイル名の後ろに“.omf”拡張子がついているファ

イル）を選択します。

3.“NewSession”ダイアログでセッションの名前、サン

プリングレート及びステレオか 5.1chサラウンドを選択

します。もし読み込んだ OMFファイルのサンプリング

レートが選択したセッションのサンプリングレートと異

なる場合、自動的にセッション作成時に選択したサンプ

リングレートにコンバートされます。

4.各設定を行った後に“OK”をクリックする事で、OMFファ

イルは Deckのセッションファイルとしてインポートさ

れます。

以上の方法で OMFファイルのインポートを行い、最終
的なミックスの作業を行う事ができます。

Deckでの作業の一例
1.Final Cut Proのプロジェクトに含まれた編集ポイント

と一致したオーディオトラックの編集が必要な場合は、

FinalCutProからオーディオエディタ（BIAS Peak等）

を起動して行う事ができます。

2. Final Cut Proから、File>Export Audio to OMFを選択し、

エクスポートを行うオーディオの名前及び場所を指定し

ます。更に“handle length.”を選択する事で、サンプリ

ングレートを調節する事ができます。（“handle length.”

は、タイムライン上の様々なオーディオクリップをまと

めてエクスポートします。エクスポートされたファイル

はタイムラインでの始点、終点の情報を持ちます。）

 さらに視覚的な参照を Deckで行う為に、QuickTimeムー

ビーとして Final Cut Proのシーケンスを Deckへエクス

ポートする事も可能です。

3.Deckを起動して“File”>“ConbertOMF”をファイルメ

ニューから展開し、ステップ 2で作成した OMFファイ

ルを選択します。一致するサンプルレートとステレオか

5.1chサラウンドのセッションかを指定し新しい Deckの

セッションを作成します。

4.以上の方法で、OMFファイルは新しいセッションとし

て Deckにインポートされ、“Mixer”および“トランスポー

ト”ウィンドウが展開されます。（セッションのインポー

トが完了次第）

 Deckの新しいセッションは Final Cut Proのシーケンスと

同じレイアウト、同じトラック数および同じ SMTPEタ

イムとフレームレートになっているはずです。Final Cut 

Proはゲインエンベロープをエクスポートできないため、
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（Deckではゲインエンベロープをインポートする事がで

きません）ゲインエンベロープの設定は、Deck上で行

う事になります。

 さらに、視覚的な参照を行いミキシング作業をするた

めに、QuickTimeムービーを QuickTimeメニューよりイ

ンポートする事が可能です。また QuickTimeムービーの

パフォーマンスは、システムや最大トラック使用数及び

使用するエフェクトに依存するため、ムービーの表示を

1/2又は 1/4のサイズに縮小してシステムへの負荷を下

げる必要がある場合もあります。

フェーダーのリンク

Deck 3.5では複数のフェーダーの動きをリンクさせる事
ができます。（リンクさせたフェーダーのうち 1つを動か
すと、リンクさせた他のフェーダーもそれに合わせて動

きます。）この機能は、一組のステレオトラックのフェー

ダーを同時にコントロールしたい場合等に役立ちます。

フェーダーのリンクを行うには：

1.ミキサーウィンドウ内のボリュームフェーダーをシフ

トキーを押しながらクリックしフェーダーを青色に点灯

させます。

2.シフトキーを押しながら、リンクしたいフェーダーを

追加して行きます。

3.リンクさせたフェーダーの内一つのフェーダーを動か

す事で、他の青く点灯したフェーダーをまとめて動かす

事ができます。また、リンクしたフェーダーの動きのオー

トメーションを組む事も可能です。

4.フェーダーのリンクを行わないようにするには、リン

クさせないフェーダー上で再びシフトキーを押しながら

クリックする事で、通常の色に戻り単独でコントロール

する事が可能になります。

CoreMIDI

Deck 3.5を Mac OS Xで使用する場合、CoreMIDIを使用
して外部の MIDI機器を使用する事ができます。外部の
MIDI機器を使用する場合サードパーティー製のドライバ
がインストールされている必要があります。ドライバの

インストール方法及び設定方法は製造元から提供される

マニュアルに従い行って下さい。
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